Troubleshooting sound quality &
recognition accuracy problems
If you are experiencing problems with sound quality and / or recognition accuracy, work through the
checklists below, whichever checklist is the most appropriate to your situation. You will find more
detail from page 6.

Checklist 1: Dragon does not hear any sound at all
If Dragon is not hearing any sound at all, this will be indicated by:


not being able to dictate anything



when you do an audio check, the blue bar on the right won’t move at all



you are not able to make a Windows Sound Recorder recording



Close Dragon and restart your computer



audio check — go to DragonBar > audio> check microphone and follow the prompts



In Control Panel sound settings — check that your recording device is set as the default
recording device



if your USB recording device does not appear in Control Panel sound settings:

Try

 try plugging the USB microphone or USB pod into a different USB port, then close and
reopen Dragon
 consider whether access to USB ports could be restricted for security reasons. If this is
the case you will need to ask IT service desk to allow access to USB ports for your
recording device.


if there are mute buttons on microphone or USB pod, make sure they are off



check that Dragon’s microphone is on



test Dragon with a different microphone and or sound card if possible, to identify whether
your equipment could be faulty, and you need a new microphone. Close and reopen Dragon
after connecting the new microphone, and do an audio check.



if using an analogue microphone, check that the microphone plugs are in the correct sockets
of the USB pod or in the computer’s mic-in-jack, matching microphone and earphone
symbols



if using a microphone that works with both Dragon and telephone, check that the
microphone is set to PC/computer and not to telephone



try to make a Windows Sound Recorder recording, to identify whether your microphone
and/or soundcard is working but Dragon is not connecting with this equipment; or whether
your microphone/soundcard is not working at all.
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Is your user profile open? Check by going to DragonBar/profiles/open user profile or Open
recent user profile. Click on your user> Open



is your user profile set up with the correct audio source?

Checklist 2: You are able to dictate but recognition accuracy is poor
2.1

Recognition accuracy has never been good

Try


Close Dragon and restart your computer



Audio check — go to DragonBar> audio> check microphone and follow the prompts



In Control Panel sound settings:
 check that your recording device is set as the default device, and
 whether Dragon might be picking up sound from more than one recording device



Consider whether your microphone and /or soundcard are suitable for use with Dragon. To
optimise recognition accuracy, use a high quality noise-cancelling analogue headset with a
USB pod, or a USB microphone. For recommended microphones see:
http://www.vivavocesrs.com/microphones-for-use-with-dragon.html
http://www.vivavocesrs.com/microphones-for-use-with-dragon-and-desktop-phone.html
 use a corded, rather than wireless microphone, especially if using Dragon in a noisy
environment;
 if using an analogue microphone that is plugged into your computer’s mic in jack,
Dragon is ‘hearing’ sound through the computer’s built-in soundcard, which might not
be adequate for use with Dragon. You could consider purchasing a USB pod (external
soundcard) to improve recognition accuracy.



Test Dragon with a different microphone and or sound card if possible, to identify whether
your equipment could be faulty, and you need a new microphone. Close and reopen Dragon
after connecting the new microphone, and do an audio check.



check the position and direction of your microphone



plug the USB pod or USB microphone into a different USB port, then close and reopen
Dragon.



if using a USB hub or a docking station, plug the USB microphone or USB pod directly into
the computer



consider whether your computer is powerful enough to run speech recognition software at
optimum performance



are levels of background noise very high?



Is your speech clear enough?



Is your user profile set up with the appropriate accent model?



Is your user profile located in the default location on the hard drive, and not on a network
drive?



Is your user profile set up with the appropriate audio source?
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Check the Speed versus Accuracy setting



If you are dictating in an application that is running on a network, and the network is slow,
this can affect recognition accuracy. Try dictating in Dragon pad (which runs from the local
drive). Go to DragonBar> Tools> DragonPad.

2.2

Recognition accuracy was previously good, but has deteriorated

Try


Close Dragon and restart your computer



audio check — go to DragonBar> audio> check microphone and follow the prompts



test Dragon with a different microphone and or sound card if possible, to identify whether
your equipment could be faulty, and you need a new microphone. Close and reopen Dragon
after connecting the new microphone, and do an audio check.



plug the USB pod or USB microphone into a different USB port



if you have a backup copy of your user profile, import it, or set up a new user profile to
identify whether the problem is located within your user profile. Perhaps your user profile
has corrupted, or deteriorated through incorrect use, e.g. not correcting recognition errors
correctly



In Control Panel sound settings:


check that your recording device is set as the default device, and



whether Dragon might be picking up sound from more than one recording device



check the position and direction of your microphone



if background noise levels have increased significantly, move to a quieter environment if that
is possible; consider purchasing a better quality noise-cancelling microphone if you don’t
already have one.



Consider whether anything has changed recently that could provide a clue as to the source
of the problem — for example a new microphone, a new computer, computer has been reimaged, operating system has been upgraded, your microphone has been transported and
could have been damaged in the move, change in IT policy has restricted access to USB
ports, or to the permissions, size and/or type of files that can be saved to the folder where
your Dragon user profile is located.



If you are dictating in an application that is running on a network, and the network is slow,
this can affect recognition accuracy. Try dictating in Dragon pad (which runs from the local
drive). Go to DragonBar> Tools> DragonPad.
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Checklist 3: Dragon does not recognise particular words
Try


Editing the vocabulary, and correcting recognition errors. Note that Dragon cannot recognise
a word that is not in the vocabulary. For more detail, see Optimising Recognition Accuracy,
available at http://www.vivavocesrs.com/tips-for-using-dragon-software.html

Tips for preventing/minimising problems with sound quality and
recognition accuracy


Use Dragon in as quite an environment as possible



speak as clearly as you can



open Dragon first, before other applications such as Microsoft Word and Outlook



always close Dragon before shutting down your computer, to avoid damaging the user
profile



Learn to use Dragon’s tools for optimising recognition accuracy, including the Vocabulary
Editor, correction of recognition errors, and Vocabulary Builder. For more information, see
Optimising Recognition Accuracy, available at
http://www.vivavocesrs.com/tips-for-using-dragon-software.html



Export a copy of your user profile from time to time. You can then import/restore the copy
of your user profile, avoiding having to set up a new user profile if for example the profile
corrupts, or you lose the profile through hard drive failure, computer reimaged, new
computer etc. For instructions on exporting and importing a copy of your user profile, see
http://www.vivavocesrs.com/technical-faqs.html



to optimise Dragon’s recognition accuracy, use a computer with as fast a processor and as
much RAM as possible. If this is not possible, maximise computing resources available to
Dragon by:
 closing any applications not in use;
 shut your computer down once a day, rather than just logging of. This will optimise RAM
available for Dragon;
 close all applications except Dragon, and dictating DragonPad (DragonBar> tools>
DragonPad). Working in DragonPad will also circumvent any issues relating to network
slowness, as DragonPad runs from the local drive.

Microphone and soundcard


do an audio check each day, or at least once a week



Use a high quality noise-cancelling analogue headset microphone with a USB pod, or a USB
microphone. For recommended microphones see:
http://www.vivavocesrs.com/microphones-for-use-with-dragon.html
http://www.vivavocesrs.com/microphones-for-use-with-dragon-and-desktop-phone.html



Be aware of the direction and position of your microphone



Use a corded, rather than wireless microphone, especially if using Dragon in a noisy
environment
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use a headset microphone with a flexible mouthpiece boom to enable correct positioning of
the microphone. Avoid desktop and lapel microphones. Earhook microphones can be
problematic for use with Dragon because the boom tends to drop down and can be difficult
to position correctly



Take care of your microphone, by protecting it from knocks and bumps. If transporting your
mic, carry it in a box or a padded bag. If away from work for a long period, and colleagues
are likely to use your desk, store the microphone in a drawer rather than on your desk.
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Further detail
Microphone and Soundcard Issues
Audio check
To bring up Dragon’s Audio Check Wizard, say “Check Audio Settings”, or by hand go to
DragonBar/audio/check microphone, and follow the prompts. Read the text in the window, first the
Volume Check, then the Sound Quality Check.
As you go through the audio check, note whether you see any movement in the blue bar on the
right. You will normally see movement in the blue bar, as Dragon adjusts the microphone settings to
the pitch and volume of your voice. However if the blue bar does not move at all, this indicates that
Dragon is not hearing anything through the microphone and soundcard.

If you are not able to proceed through the audio check, this indicates that the sound signal Dragon is
hearing is not adequate.

Test Dragon with a different microphone
If you have a spare microphone, or are able to borrow one, test Dragon using that microphone. If
Dragon works fine using a different microphone, that will clearly indicate that the problem is with
your microphone.
After connecting a new or different microphone, close and then reopen Dragon, then do an audio
check. If you are not able to dictate after connecting the new microphone, check that the new
recording device is selected as the default recording device in Control Panel/sounds.
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Do a Windows Sound Recorder recording
A Windows Sound Recorder recording will establish whether the microphone/soundcard is working.


If you are not able to make a recording — that is, Windows Sound Recorder does not hear
any sound, or the sound quality when you play back is poor, this indicates that your
microphone and/or soundcard is faulty.



If on the other hand you are able to make a recording and when you play the recording, the
sound is clear, this indicates there is nothing wrong with the microphone or soundcard but
there is something wrong with Dragon or Dragon is not picking up the microphone or
soundcard.

Windows 7
Click on the start menu > type ‘sound’ into the search field at the bottom, then look at the top of the
list you should see 'Sound recorder', click on that.
Click Start recording and dictate a few sentences. If you see any green movement in the bar, that
indicates sound recorder is hearing sound.

Click Stop recording, save the file to the desktop, give it a name e.g. Dragon test
Now go to the desktop and double-click on the file, it should open automatically in Windows Media
Player or your default player.
Windows XP
1. Start / Programs / Accessories / Entertainment / Sound Recorder.
2. Click the File Menu / Properties / Convert Now button.
In the Name drop down list select CD Quality. Each time you make a new recording it will
default back to the previous setting.
3. Click back to Sound Recorder by clicking OK
4. Click the Edit Menu - Audio Properties. Make sure the Preferred Recording device in the
drop down list is selected for the device you are using with Dragon.
5. Make a recording by clicking on the Red button. Dictate for 10 seconds or so. If you have an
On/mute switch on your mic, make sure it is in the “On” position. As you record, the flat
green line should show bubbles as the sound comes through. Click the rectangular black
button to stop recording, then click the playback arrow to play back the sound.
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Playing back your recording
Can you hear any playback? Note the quality of the sound — does it sound clear or is there crackling
and static?

Do you need a new microphone?
If you are not able to record any sound at all in Windows Sound Recorder, or the sound quality is
poor, and you have worked through all the checks above, it is possible that your microphone is
faulty. Your microphone might have been damaged, or reached the end of its useful life, and it’s
time to purchase a new one.
If using an analogue headset microphone with a USB pod/external soundcard, note that it’s much
more likely that the microphone is damaged or has died, than the USB port. With regular use, many
microphones will not last longer than two years. USB pods are more robust than mics, and generally
last much longer.
For this reason, it can be a good idea to purchase a separate analogue headset microphone and USB
pod, rather than a ‘USB microphone’ which is an all-in-one unit. If you purchase a USB microphone,
you will need to discard the whole unit when the headset microphone dies. Long-term replacement
costs can be lower if you purchase an analogue headset and USB pod as separate items.
Even if your microphone is relatively new, it’s worth considering the possibility that it is faulty.
For recommended microphones see:
http://www.vivavocesrs.com/microphones-for-use-with-dragon.html
http://www.vivavocesrs.com/microphones-for-use-with-dragon-and-desktop-phone.html
Taking care of your microphone
Microphones are designed to pick up vibrations in the air and as such are sensitive to larger shocks.
It is not uncommon for microphones to fail completely, or for their performance to deteriorate after
around two years of regular use.
To optimise the longevity of your microphone:


treat it gently, and avoid knocks and bumps as much as possible;



If transporting your microphone, put it in a box or Padded bag. Microphones will be easily
damaged if carried in a bag without any protection;



if away from work for a long period of time, store your microphone in a drawer rather than
on your desk.
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Is your microphone suitable for use with Dragon?
If you have never achieved a high level of recognition accuracy while using your current microphone,
consider whether your microphone and/or soundcard are suitable for use with speech recognition
software. Dragon requires a high quality, noise-cancelling microphone and soundcard or USB pod.
Are you using a wireless microphone in a noisy environment? Note that wireless microphones do not
generally perform well in noisy environments, including open plan offices.
Are you using a desktop or lapel microphone? A headset microphone is best, to ensure optimum
positioning of the microphone close to your mouth.
For recommended microphones see:
http://www.vivavocesrs.com/microphones-for-use-with-dragon.html
http://www.vivavocesrs.com/microphones-for-use-with-dragon-and-desktop-phone.html

Is your soundcard suitable for use with Dragon?
If using an analogue microphone without a USB pod, i.e. plugged into the computer’s mic-in-jack,
Dragon will be ‘hearing’ sound through your computer’s soundcard. Unless your computer’s
soundcard is high end, it’s likely that you will achieve a higher level of recognition accuracy by using
a USB pod /external soundcard. For more information see
http://www.vivavocesrs.com/microphones-for-use-with-dragon.html

Check that Dragon’s microphone is on
This will be obvious to most Dragon users, but just in case any new users don’t know how to turn the
microphone on: click the microphone icon, to the left of the DragonBar.
mic is on

mic is off

mic is asleep

You can assign a keyboard shortcut for turning the microphone on and off, at DragonBar> tools>
options> hotkeys.

If using an analogue microphone, are plugs in the right sockets?
If using an analogue microphone, it will be plugged into either the computer’s mic in jack, or a USB
pod. Check that the plugs are in the right sockets, matching the microphone and earphone symbols.
With most microphones, you can also match the colours, pink usually being for microphone and
green for earphones, although it’s important to note that this is not the case with all microphones.

Check the positioning and direction of your microphone
Direction
Most microphones used with Dragon are directional mics, and need to be facing towards you. Most
microphones will have a mark on the mouthpiece to indicate the correct direction.


VXI TalkPro parrot microphones have a white dot on the mouthpiece boom.



VXI TalkPro SC1 microphone has a raised mark on the mouthpiece boom
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the Soundshield 4G has a small raised mark on the mouthpiece boom. The direction of the
microphone under the foam should be perpendicular to your face — you can feel the
direction of the microphone through the foam.

Position the microphone:


level with your mouth — don't let it drop to chin level;



at the corner rather than directly in front of your mouth, so it doesn't pick up breath noise;



one or two thumb widths out from your face .

Is the mute button off?
Some microphones have a mute button. Make sure the mute button is off.
Some USB pods also have a mute button, including Buddy USB pods. Buddy USB pods will flash blue
(Buddy 6G) or orange (Buddy 7G) if the mute button is on. If using a Buddy USB pod and you see a
flashing orange or blue light, press the mute button on the USB pod to unmute. Green light only is
what you should see with Buddy USB pods, indicating that the mute button is off.

If using a microphone that works with both Dragon and telephone, is it set to
PC/computer and not to telephone?
If using a microphone that works with both Dragon and telephone (e.g. Polaris Soundshield 4G),
make sure the microphone is set to PC/computer and not to telephone.
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Windows Control Panel Settings
Check that your preferred recording device is the default device
Check that your preferred recording device is set as the default device in Control Panel settings.
Your preferred recording device will be either a USB pod or USB microphone , if you are using an
analogue headset microphone without a USB pod, your computer’s on-board soundcard (which is
not recommended unless you have a high end on-board soundcard).
Windows 7
Go to Control Panel/sound/recording. Check that your preferred recording device is the default
recording device. It should have a green tick. If your recording device is not set as the default
recording device, select the device, then click Set default > OK

Windows XP
Go to Control Panel > sounds and audio devices >audio> Sound recording.
Check that your recording device is selected as the default device. Check Use only default devices.
Click OK.
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Is Dragon picking up sound through any recording devices other than the default
device?
It’s important that Dragon is picking up sound only through the default recording device. It is
possible, particularly with laptops with built-in microphones, that Dragon is hearing sound through
more than one device. I have only encountered this problem with Windows 7, not Windows XP.
To check, go to Control Panel> Sound> recording.
Make some noise and see whether there is any green showing in the bar to the right of any of the
recording devices other than your preferred device. If this is the case, it indicates that Dragon is
hearing sound from more than one device.
Even if you don’t see any green movement, if any recording device other than your preferred device
has a bar showing to the right, it’s a good idea to disable these recording devices, to ensure that
Dragon is hearing sound only through the preferred recording device.
The image below shows Control Panel/sound/recording — the bars to the right indicate that Dragon
could be hearing sound from more than one recording device.

How to disable recording devices
In Windows 7, go to Control Panel/sound/recording
Select the recording device/properties/Select Don’t use this device (disable) from the Device usage
list.
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The image below shows Control Panel/sound/recording after all recording devices other than the
device being used with Dragon have been disabled.
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User Profile Issues
Speed versus Accuracy setting
If you are experiencing poor recognition accuracy, try adjusting the Speed versus Accuracy setting.
Go to DragonBar/tools/options/miscellaneous. Move the slider bar towards Most Accurate. Note
that there is a trade-off between speed and accuracy so if you find Dragon works slowly, then you
will need to adjust the slider bar more towards Fastest Response. You can experiment with this
setting to see which is the best trade-off between speed and accuracy. The optimal setting will
depend on how powerful your computer is. If you have a really powerful computer you can move
the bar all the way over to Most Accurate.
After adjusting this setting, click Apply/OK.

Is your Dragon user profile set up with the appropriate accent model?
To check which accent model your user profile is based on, go to DragonBar> profile> Open user
profile. Click on your user profile> properties.
If you have an Australian accent and your user profile is set up with a different accent model for
example US or UK, this could explain poor recognition accuracy. It is not possible to change the
accent model, you will need to set up a new user profile.
Note re other accents:


New Zealanders generally do better on UK accent model than Australian. The solution
would be to set up a new user profile.



Dragon users who speak English with a continental western European accent could try UK
accent, as continental European vowels tend to be closer to UK English than Australian
English.
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Accents available in Dragon 12
When setting up your user profile, the Region you choose will determine the accent model. New
Zealanders please note that if you select Region: New Zealand you are not actually getting a New
Zealand accent, you will get Australian accent model . I recommend that New Zealanders choose
United Kingdom as this accent model is the best match.

Is your Dragon user profile set up with the appropriate audio source?
Go to Dragon bar/profile/open user and check what the audio source is. Look under Source, which
you will see at the top of the dialogue.
If using a USB pod or USB microphone, the source should be ‘Microphone (USB)'.
If using an analogue microphone plugged into the computer’s round mic-in-jack (see image below),
the audio source should be ‘Microphone (Mic-in)’.
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In the image of the Open User Profile dialogue below you will see that there are two user profiles,
and one of those profiles has two different audio sources. Most Dragon users will have only one user
profile, with one audio source.

If your user profile is not set up with the appropriate audio source, you can allocate a new source by
clicking on your user profile in the Open User Profile dialogue, click Source (the button on the right
of the dialogue)/ New / then select the appropriate source from the list, which will most often be:
1. ‘Microphone (USB)' if using a USB microphone or USB pod; or
2. ‘Microphone (Mic-in)’ if using an analogue microphone plugged into the computer’s round
mic-in-jack.
If using a different kind of microphone, for example wireless or Bluetooth, or you are using a digital
recorder to transcribe, choose the audio source that looks most appropriate.

Follow the prompts from here.
You will now have one user profile with two audio sources. To ensure your new audio source is
open, go to DragonBar/profile/open user /click on the appropriate source / Open.
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To delete an unwanted audio source, go to DragonBar/profile/open user profile/click on the audio
source you don’t want/Source/Delete. Note that it is not possible to delete a Source that is open.

Location of the user profile
The user profile should be located on the local drive (i.e. the C or hard drive).
To check the location of the user profile Go to Dragon bar/profile/open user. If Location of user
profile shows as default, this indicates the user profile is located at the default location which is the
local drive.
For Windows 7, the default location for theDragon NaturallySpeaking 12 user profiles is:
C:\ProgramData\Nuance\NaturallySpeaking12\Users
If the location is a network drive, this can cause serious problems with Dragon including poor
recognition accuracy and slowness. It’s important that the user profile is relocated to the local drive.

How to change the location of the user profile
In Windows Explorer, browse to the location of your user profile. You will find the location in the
Open User Profile dialogue, next to Location of user profile. Copy the User profile.
In Windows Explorer, browse to the new location and paste the User profile.

Go to DragonBar/profile/open user profile and click on Browse (at the bottom right of the dialogue)
and browse to the new location. Follow the prompts from here.

Roaming user feature
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Note that when the Roaming User feature is used, a copy of the user profile is located on a network
drive, however the profile is copied to the local drive when Dragon is opened, and copied back to the
network drive each time Dragon is closed, so the user profile still effectively runs from the local
drive.

Corrupted user profile?
It’s possible that your user profile has corrupted, or deteriorated over time through incorrect use,
for example if you have not been correcting recognition errors correctly.
To test whether the problem is related to your Dragon user profile, you could set up a new profile,
or restore/import an earlier version of your user profile, if you have taken a backup. For instructions
on exporting and importing a copy of your user profile, see
http://www.vivavocesrs.com/technical-faqs.html
If you don’t have a copy of your user profile, you will need to set up a new one. Go to
DragonBar/profile/New user profile, and follow the prompts. For more detailed instructions on
setting up a new user profile, see
http://www.vivavocesrs.com/tips-for-using-dragon-software.html
To make sure your new user profile is open (and not the old user), go to Dragon bar/profile/Open
user profile.

Other Issues
System requirements for Dragon
Dragon is resource hungry software and requires a fast processor and plenty of RAM to work well. If
your processor is not fast enough, and you don’t have at least 4 GB of RAM for Windows 7, this
could affect Dragon’s recognition accuracy.
Try closing all applications except Dragon, and dictate in DragonPad. Say “Open DragonPad” or go to
DragonBar/tools/DragonPad. This will maximise resources available to Dragon and could improve
recognition accuracy.
For recommended computer specs, see
http://www.vivavocesrs.com/technical-faqs.html

Problems with USB ports
If the USB port is faulty, plugging the USB pod or USB microphone into a different USB port could
resolve the problem. Close Dragon and reopen after you have reconnected the microphone.
If using Dragon at work, it’s possible that access to USB ports has been restricted to particular
devices (for example to mouse and keyboard only) for security reasons. If this is the case, the USB
microphone or USB pod will not appear in Control Panel/sound/recording (Windows 7) or in Control
Panel/sounds and audio devices/audio/recording (Windows XP). If you suspect that access to USB
ports is restricted, you will need to request your IT service desk to provide access to the USB ports
for your recording device.
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Speaking style
Many people underestimate how clearly you need to speak to Dragon to achieve a high level of
recognition accuracy. Dragon will generally not recognise you well if you speak in a conversational
style.


speak as clearly as you can —as if you were reading the evening news, don't speak in a
conversational style



an assertive, punchy style works well. Talk like you expect Dragon to obey you.



avoid running words together



articulate each syllable and word more than you would in normal speech. Take particular
care to articulate the 'little' words clearly — ‘the’, ‘for’, ‘all’ etc



Speak in long phrases wherever possible, this gives dragon more context to work with




don't elongate words
pause before and after commands, but not in the middle

Background noise
When using Dragon, the quieter the environment the better. Use of a high quality noise-cancelling
microphone and soundcard will minimise the impact of background noise however even the best
quality microphone will not be able to a perfect job at noise cancelling.
Very high levels of background noise will impact on Dragon’s performance.
If there is not a lot of noise coming from one direction, and you don’t mind which side of your face
the mouthpiece boom is on, position the mouthpiece boom on the left or right side of your face so
the inside of the mouthpiece is facing towards you, and away from the source of the noise. That is, if
the noise is coming from the left, wear the mouthpiece boom on the left side of your face. If the
noise is coming from the right, wear the mouthpiece boom on the right side of your face.

Dragon does not recognise particular words
If Dragon does not recognise particular words, recognition accuracy can be improved by editing the
vocabulary, including adding words and phrases, training your pronunciation of particular words and
deleting unwanted vocabulary.
To open the Vocabulary Editor say “Edit vocabulary”. For more detail, see the document Optimising
Recognition Accuracy, available at
http://www.vivavocesrs.com/tips-for-using-dragon-software.html

Network slowness
If you are using Dragon in an application that is running from the network, for example Microsoft
Word or Outlook, and the network is very slow, this can affect Dragon’s speed and accuracy.
You could try dictating in DragonPad which runs from the local drive, then copy and paste your text
into the network application. To access DragonPad, go to DragonBar> tools> DragonPad.
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